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c)\.,)Jse the Home tab to apply Uberschrift 1 to the text that you want to appear here.

1 About this Manual

The content of this manual shows you how to work with the Vendor Managed Inventory process.

1.1 Abbreviations

Abbreviation Meaning

ASN Advance Shipping Notice

Csv Comma Separated Values

ERP Enterprise-Resource-Planning

Max Maximal

Min Minimal

VMI (IPR) Vendor Managed Inventory (Inventory Projection)
WebEDI Web based EDI

XLSX Excel 2010
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2 Introduction to the Vendor Managed Inventory
process

The Vendor Managed Inventory (VMI) is an approach where you as a supplier are responsible for
the management of the stock held by your customer.

The material assigned to the VMI (IPR) process does not appear as a demand in the purchase
order overview.

Your customer will provide appropriate demand forecasts, their current inventories as well as
minimum (Min) and maximum (Max) stock levels on a regular (usually daily) basis.

You should apply the correct replenishment actions in order to trigger appropriate deliveries of the
requested material to your customer’s warehouse and keep the material stock between this Min &
Max levels.

Stock quantity

A
MAX

Stock levels

MIN

0
Current time Projected time

2.1 Stocks levels

There are several stock types:

v Actual stock: - the quantity of goods present at the current time

v" Projected Stock: - describes the evolution of the available stock in the future

As soon as the application detects irregular cases (e.g. an out-of-stock situation), an alert is raised.

Thanks to that, you may only need to react if an alert is raised. If there are no alerts raised by
SupplyOn concerning a VMI material, there is no need for you to perform replenishment actions for
this material.
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The following types of alerts are available:

v'If the inventory level is not between the agreed Min & Max
v"If the inventory level is not between the agreed Min & Max at the end of the day
v

If the inventory level is not between the agreed Min & Max in the future

You need to set up the alerts by yourself as described here.
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3 How to access SupplyOn

To work with SupplyOn your company administrator needs to set up an account and initial
password for you. The administrator will assign the appropriate roles to you (see chapter 8, Roles

and Rights).

Your customer sends demands and their stock levels from his ERP system(s) on a regular basis.
Based on this information, you are enabled to manage your deliveries. There is no automatic e-
mail notification as you are used from other processes.

Open an internet-browser and log in to SupplyOn.

SupplyOn - The Supply Chain B X

) https//www.supplyon.com

=
SUPPLYQN ) swpport  Englsh v Search

SOLUTIONS INDUSTRIES CONSULTING CUSTOMERS TRAINING FOR SUPPLIERS

Emerge stronger from the
pandemic by implementing
a Control Tower approach
For your supply chain.

READ THE GATNER REPORT > Act now!

4 steps to gain full control over your supply chain - not only in times
of crisis

1 2 2 4

GARTNER 2020: SUPPLYON RECOGNIZED AS A LEADER IN MAGIC QUADRANT

Figure: SupplyOn home page with Login button
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Depending on your roles, you may see different tiles than used in the following screenshots.

1. Click the tile Logistics & Finance

—
SUPPLYON
!

Home.

Help & Support

Feedback

SupplyOn Services v

SupplyOn > Home

Action Management >

Share action plans with your
customers.

Collaboration Folders >

<

Work on development projects
with your customers.

Logistics & Finance

Access the demand and delivery
processes including E-Invoicing.

Administration v

AirSupply Logistics >

Access the demand and delivery
processes including E-Invoicing.
concession and notification of
escape for the aerospace industry.

Document Management >

Receive and review important
documents from your customers.

Performance Monitor >

~

Find key figures on the product
and delivery quality of your
customers.

Business Directory

3]

Find the master data of your
company.

Flexible Survey

Find and edit surveys from your
customers

Problem Solver

0

Actions due wilhin 24 hours

0

Are you using the best
browser?

Please use Google Ghrome.
Mezila Fircfox or Microsol
Edge (Chrome-based versions
since January 2020)for
highest specd and
funcionly. More

Congratulations - you
have no urgent tasks

Figure: Home screen with tiles per application and actual notifications
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4 How to work with the Dashboard

The Logistics & Finance Dashboard is displayed.

Depending on your roles, you may see different tiles than used in the following screenshots.

Figure: Dashboard

4.1 What | can see in the VMI (IPR) tile

Within the VMI (IPR) tile you see material-based alerts.

v' Projected Stock: Inventory Alerts — the sum of all alerts
v" Actual Stock: Inventory Alerts — the sum of alerts based on the Actual Stock status
v/ Material Situation at the end of today:

o Below Zero: — the actual stock is below zero at the end of the day

o Below Min Limit: — the actual stock is below the agreed minimum level at the end

of the day
o Above Max Limit: — the actual stock is above the agreed maximum level at the end
of the day
VMI (IPR) >
Projected Stock: Inventory Actual Stock: Inventory
Aleris Alers
Material Situation at the end of today
|
Below Zero 8
Below Min Limit 2
|

Above Max Limit 1

Figure: Dashboard / tile / VMI (IPR)
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5 How to work with the Inventory Projection

5.1 How to open the Inventory Projection

1. To get an overview of all material numbers managed by VMI (IPR), click ->

VMI (IPR)

Figure: Dashboard / tile / VMI (IPR)

In this example 18 different material numbers are flagged by your customer with VMI (IPR) and
appear in the IPR Materials overview screen.

Iy SupplyOn > Logistics & Finance » IPR Materials Contact | @ Help for this page | Print

Quick Search  Agvanced Search

l:l,, Add ine | Delete fine My Search Profiles

Search | | Reset ~ | Manage View~

Hide Search Area

IPR Materials RPM Materials

[vircutsven | [Manage View~ Reset s

[ Mmaterial Material Desc. Status  IStock. Stock. Demand 1. In-transi. Min. Max. 1st Stock Out | First "Below Min.” Sit. | First "Above Max" Sit. Code Buyer Plant Buyer Unloading P. Bu
[ 456983 [} sa) 0 -271900 271900 0 0 0§ 16/0821 16/08/21 MX01 B. Fischer Mexico B. Fischer Me. BF
[ 11348008 [ aal 9507  -22758 38265 6000 4500 7300 | 16/08/21 1608121 mo1 B. Fischer ltalia Trennfurt-A BF
[ 2025338 ] aa) 2628 -659 3287 0 300 1600 ) 16/08/21 16/08/21 To1 B. Fischer Italia Bekaert BF
[ NUK-000017 ] sa) 0 -250 250 0 0 0§ 16/0821 16/08/21 To1 B. Fischer Italia N-UK Gate 1 BF
£ ASA-000024 ] =a) 661 -2639 3300 0 100 200 | 16/08/21 16/0821 To1 B. Fischer Italia DEMO1 BF
[E] ASA-000041 [} i) 671 -2629 3300 0 200 600 | 16/08/21 16/0821 ITo1 B. Fischer Italia DEMO_VT BF
[ 995555 | sa} 0 0 0 0 1000 5000 16/08/21 mo1 B. Fischer alia BF
[ 456933 - 4562 -267338 271900 0 1000 5000 16108121 16008721 MX01 B. Fischer Mexico B FischerMe . BF
[ NUK-000010 L] 0 2000 54 000 56 000 2000 5 000 mo1 B. Fischer Italia N-UK Main Gate BF
[ 456828 ] sa) 3264 -244 536 247 800 0 3000 10 000 | 16/08/21 16/08/21 MX01 B. Fischer Mexico B. Fischer Me. BF
[ 993745 L1} 3473 3207 1416 1150 2700 6 000 180821 To1 B. Fischer Italia B. Fischer Italia BF
345828 Sealing 2] 7922 7922 0 0 7000 12 000 23/08/21 MX01 B. Fischer Mexico B. Fischer Me. BF
[ 890128 Casing 222 2570 6272 1098 4800 1000 2000 17/08/21 1T01 B. Fischer Italia B. Fischer ltalia BF
[ 1234428 L] 9200 1788 1212 3800 1000 3 400 DEO1 B. Fischer DE 7501 BF
B 127376 =22 2625 2217 1176 768 6810 1566 126/0821 2300821 17/08/21 mo1 B. Fischer alia B. Fischer Italia BF
[ 345828 us) 7922 10022 0 2100 950 5 000 17/08/21 mo1 B. Fischer Italia B. Fischer Italia BF
[ 747490 L] 2242 1299 943 0 500 3 000§ 23/08/21 2100821 mo1 B. Fischer Italia B. Fischer Italia BF
[ NUK-000003 ] aa) 1000 -53 000 54 000 0 2000 3000 § 16/08/21 16/08/21 ITo1 B. Fischer Italia N-UK Main Gate BF

»

[Create ASN] [Delivery Note Items| [Master Data] [[inventory Projection]| [Download- | [Pianned Receipts- |

18 maches o 0 antaen: _ Seoc s materas | Ciar setecnon conesperssse [50 | page [ 1] o1

The columns marked in green give you an actual overview of the stock situation per product.
The Status represents the following color codes:

Red: - Stock out

v

v" Orange: - below minimum
v' Blue: - over maximum

v

Green: - ok

The Min and Max columns show the limit levels defined by your customer, and the column First
“Below Min.” Sit. shows when the stock is expected to get below the minimum.

2. Select the material you want to work with by setting a tick

3. And click Inventory Projection.

Figure: IPR Materials / Overview
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The Inventory Projection screen is divided into three areas:
v' Diagram and table — overview of actual and projected stock levels and their position related
to the min & max range, demands and planned deliveries including a graphical visualization

v" Material Details — information like rounding and minimum delivery quantity, timestamps of
last stock messages as well as order and ASN references

v' Legend - explains the color codes in the diagram

The following buttons help with:

v' Master data — changing the selected material master data like for example rounding and
minimum delivery quantity

v" Configure view — changing the actual view of the diagram

Inventory Projection for Material 345828 (Sealing) - B. Fischer Mexico

@ Diagram
[
© Table 2021-08-14 20210815 2021-08-16 2021-08-17 - K = = X 021-W34 z
Inventory Start v 702 702 7922 7022 ¢
In-Transit Quantities 0 0 9 0

Planned Receipts v

0 0 0 0
g 3\

Demand v

Inventory End S 7e2 702 782 TET6

Win. Inventory 7000 7000 7000

Max. Inventory 12000 12000 12 000

Average Demand 55 56.2

« ,
[T TYateraT Detane
Stock Buyer  Consignment  Order Reference 3627447 Update Timestamps

Total available 7922 7922 0 Latest ASN 430 Inventory 16/08/21 02:48:15

Unrestricted-use stock 7892 7892 0| Latest ASN with Goods Receipt 30000375 Demand 16/08/21 02:48:14

Qualty inspection stock 30 0 0 Latest Delivery Note GIA14578 ASN / Delivery Note 1810821 02:48:14

Blocked stock 2 2 0 Latest Delivery Note with Goods Receipt LSNLO1_06  Goods Receipt 12007715 02:20:01

Planned Receipts 12008121 05:57:42
Safety Stock Calc. Method AvgDemand

Minimum Inventory 7 000EA Rounding Delivery Quantity 1 Material UoM EA

Maximum Inventory 12 000EA Minimum Delivery Quantity 1 Teansportation Time 4ghour(s)

Calculated Coverage () unlimited / unlimited Day(s) Process Key RPM
(0 Legend

Inventory at the End of ngaﬂvs .
Inventory Diagram the Timebucket In-Transit Quantities Planned Receipts Pm] Stock Max. Inventory Min. Inventory
SRR %
ento o CEE | R %

[Back] [Master Data] [Configure View]]

Day configured not available in plant
‘calendar

Figure: Inventory Projection with marked areas and buttons

5.2 How to plan your deliveries
The following screens and actions are examples to explain how to plan your deliveries.
The screenshot shows that the stock level slips below the agreed minimum quantity in calendar

week 34. The minimum agreed quantity is represented by the yellow line. The maximum agreed
guantity is represented by the blue line.

Mwanicey Projection or Meless AGEZS {Seatieg) - B. Fscher esico
© Diagram

D Tatie

Inventary Start w
In-Tran tios

entary End
Min. inventory
Mai Iaventor
Average Demand
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Figure: Inventory Projection diagram and table

The transportation time for this material to the customer location is defined with 48 hours. This is a
setting you define in the master data as described here. This ensures that you cannot plan a
delivery within this defined period. In the screen above the 16" and 17" August are blocked in the
Planned Receipt line.

©Material Details
Stock Buyer  Consignment  Order Reference Update Timestamps

Total avaiable 7922 7922 O LatestASN ol 160821024815
; - L O Latest ASN with Goods Receipt 8 14
2 X 3 Latest Delivery Note 8:14

< Latest Delivery Note with Goods Receipt o

Safety Stock Caic. Method Avg Demand

Winimum Inventory 7000EA Rounding Delivery Quantity 1 Material Uot EA
Maximum laventory 12 000EA Winimum Delivery Quantity 1 [Transporiation Time E0)

Calculated Coverage unlimited / unlimited Day(s) Tocess Koy RF

Figure: Inventory Projection with material details and the defined transportation time

1. Enter into the planned receipts field for August 21st the quantity 1200.

As a result, you can see that there is no critical situation within the following days anymore. The
planned receipts are shown in light grey on top of the dark grey bar. As soon as the goods are

received by your customer and the stock level is updated the quantity will be added to Inventory
level.

Inventory Profection for Material 345625 (Sealing) - B. Fischer Mexico
© Diagram

@ Table nitiEr 2021-08-16 2021-08-17 2021-08-18 2021-08-19 = = 2021-08-22 2021-W3F 2021-W35 2021-W35 2021

Inventory Start v 7822 7922 7676, 7676, 8450 8233 7543 7302
In-Transit Quantities v 9 0 [ [

0 0 0 0
AN il [0 q|E] o] s} o]

Demand v 0 0 25 0 217 590 241 0

Inventory End

. 7e@ 76768 7676 7

Min. Inventory 7,000 7000 7000 7000
Max. Inventory 12 000 12000 12000 12000 1

65 2 2 7 41 El 1 0 0

Average Demand

v

Figure: Inventory Projection with diagram, table and planned delivery

5.3 How to create an ASN out of VMI

Inform your customer about the shipment of your planned delivery with an ASN.

1. Move your mouse over the In-Transit Quantities area and
2. select create ASN.

Inventory Projection for Material 345828 (Sealing) - B. Fischer Mexico
@ Diagram
0
@ Table niiar 2021-08-T6 2021-08-T7 z = 2021-08-27 2021-08-27 2021038 2021-W35 2021-W36 2021
ienion Star 7922 7922 7922 7250 8 450 8233 7543 7302
In-Transit Quaniies 0 0 0 0 [ 0 0 o [ 0 o
Flanned Receipts v@ Delvery Note ftems | 7777777777777 q 1200] [l || L[| 9|
Demand v 0 0 246 0 0 217 590 341 L
Inventery End = | 7e2 7e2 766 766 S
Min. Inventory —— 7000 7,000 7000 7000 7000 7000 7000 7000 7000
Max. Inventory 121000 12000 2000 12000 12000 12 000 12000 12000 12 000 1
Average Demand 55 2 ) 7 41 41 3 1 0 o
< »

Figure: Inventory Projection view with diagram and activated selection for creating an ASN
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3. Define the time frame for the planned receipts to be considered for delivery

4. and click apply.

e

Table initial 2021-08-16
=
Inventory Start « T 922 T 022
In-Transit Quantities - .

Planned Receipts Question

2021

Cemand Consider planned receipts until: |22.'08F21| |B|
Inventary End
Min. Inventory
Max. Inventory
Average Demand

Apply | | Cancel |

Figure: Inventory Projection view with question box for considered planned receipts

The Create ASN screen is displayed. Continue to create an ASN as described in the
‘Handout for the SupplyOn Service Logistics & Finance. Advance Shipping Notice (ASN)’,

which can be found on the Supplier Info Portal.

My SuppiyOn > Logisties & Finance > Create ASN

Gompany Name (Customer): _trg-B. Fischer AG (DEMO COMPANY) Ship-to-Location MX01/BCG1 Unloading Point (Consignee). B. Fischer Mexico

Select ASN Positions. Complete ASN

Default View ~ | Manage View~

Lines | Del.NoteNo.  Del. Note Pos.  Material No. (Customer) ASN Creation Due... Proposed Deivery UoM  Wam. Pack.. PackMat. Packing Profile Eng . OrderNo.  Order Pos.
=1 010 345828 11/08/21 0500 1200 1200] EA a M Defals |<manual daia entry> 3627447 1

“«
Add New Line~ Delete Line| | Calculate Packing|  Create One-Level Packing

Sentry:  Soectall matehes | Clear slocton Envicsperpsge [20_|v

Contact | @ Help for this page | Print

New

Reset allFiters

‘Amount SP Qty. per Pac
0
.
page [ 1] o1
Em

Figure: Create ASN with Select ASN Positions tab

As soon as you have sent the ASN, the planned receipts quantity will be reset to 0 and the line

In-Transit Quantities will show for this example the quantity 1200.

My SupplyOn > Logistics & Finance > Inventory Projection
Inventory Projection for Material 345828 (Sealing) - B. Fischer Mexico
@Diagram T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T
(=) Table initial 2021-08-16 2021-08-17 2021-08-18 2021-08-19 2021-08-20 2021-08-21
|nventory Stad_w 192 792 7922 1676 1676 7465 7250 8233
n-Transit Quantities v 0 0 0 0 0 7200] 0 0
lanned Receipts v q 0 o o) 9] q
emand v 46 0 11 215 0 217, 690
Inventory End ]
Min_ Inventory 7000 7000 7000 7000 7000 7000 7000 7000 7000
Max_ Inventory 12 000 12 000 12 000 12 000, 12 000 12 000 12000 12 000 12 000
Average Demand 65 56.2) 56.2 48.7 41 41 333 8.61
‘<
Figure: Inventory Projection view with new stock view with In-Transit Quantities number and stock

August 2023



P
SUPPLYON )
y

As soon as your customer has received the sent material, the In-Transit Quantity is reset to 0 and
the Inventory Start will show a plus of 1200.

5.4 How to view the demand details and history

The Inventory Projection screen offers additional details about the demands the customer sends.
You can either open the details or the history.

1. Move your mouse over the demand area and select either Demand history or Demand

details
Inventory Projection for Material 345828 (Sealing) - B. Fischer Mexico
[ o
0

(=) Table initial
Inventory Start v 7922 7922 7676 7676 7 465 7 250 8 450 8233
In-Transit Quantities 0 0 0 0 0 0 0 0
Planned Receipts o7 7 7| of of 1200] o[ ql

0 248 0 211 215 [ 217 590

Tnventory Bug | Demand History 7922 7676 7676 7485 7250 8450 8233 7543
Min. Inventq 7 000 7 000 7 000 7 000 7 000 7 000 7 000 7 000
Max. Inventi Demand Detalls 12 000 12 000 12 000 12 000 12 000 12 000 12 000 12 000
Average Der 562 562 487 41 41 333 8561

Figure: Inventory Projection view with diagram and activated selection for Demand

Within the Demand History you can see if and how a demand has changed within a certain time
period. You define the time period of the messages and how many time buckets you want to see.
A time bucket can be a day, a week or a month.

My SuppiyOn > Logistics & Finance > Demand History Contact| @ Help for this page | Print

Demand History for Material 345628 (Sealing ) - B. Fischer Italia - rg-SAPHIR S 4 (DEMO GOMPANY)

Timestamp of Transmission ~ from [09.09.21 |3 days back
Demand Date from [25.0821 |[% buckels ahead
Display of Demand Time Buckets O aaiy ® weeky O monibly

Document Type DocumentNo. | Message Timesta... | Change Timestamp 2021-W34 2021-w3s 2021-W36. 2021-W37 2021-w38 2021-w39 2021-W40 x
Delveryinst gross 00003 07.0921 11.03 07.08.21 11:05 212 3207 830

Deliveryinst gross 00003 2508211556 2508211557 2349 3477 1406

,
FT— s por poge & vage [ 1] o1

Figure: Demand History with details of demand messages

2. Click Back to return to the Inventory Projection screen.

Within the Demand Details you see the demands displayed in the layout of a delivery instruction.
Here you can either Download or Print the demands if needed. From here you can also view the
Demand history.
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My SupplyOn » Logistics & Finance = Deiivery Schedules > YMI-Demand (IPR) Details Gontact| @ Help for this page | Print

‘VMI-Demand (IPR) Details Partner Information Additional Information

Waterial Related Information B
Document No. 00003 Transmission Date: 07.09.21 11:03 Validity Period: -
Buyer Material Number. 345828 Supplier Material Number Planner.
Material Description Sealing Message Number 00003
Engineering Change Level Uo EA Supply Model M
Incoterms EXWFrankatur Text Order Number 3627447 Order Position 1
Production Release: Delivery Instruction Number: 1 Date 220921
Material Release: Delivery Instruction Number Old: 2 Date

Additional Reference Data
Current cumulated quantlty received 0 Start date of current cumulated quanthty Last cumulated quantity before resetting

Cumulative quantities

Buyer 0
Supplier: 4.180 | Save
Quantity from ASNs in draft status. 0
Status ok

VMI-Demand (IPR) Schedule Lines

Default View ~ || Manage View~

Delivery Date » Pickup Date Dispatch Qty. cum. Quantity Difierence  Gommit Del...

07.09.21 359 Fix 359
08.09.21 498 Fix 498
09.09.21 482 Fix 482
10.09.21 a37 Fix 437
110821 517 Fix 517
120021 479 Fix 479
13.00.21 444 Fix 444
14.00.21 497 Fix 407
15.00.21 537 Fix 467

| Demand History| [Download - |
»

Figure: VMI-Demand (IPR) Details with the Demand History, Download and Print buttons

3. Click Back to return to the Inventory Projection screen.
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6 Material master data | can define by myself

You can update relevant material master data. For that you need the role as described here.

1. Open the Logistics & Finance Dashboard

2. Scroll down to the tile Settings and Master Data

3. Open the Material Master Data

Logistics & Finance

2% Dashboard

BB Demand @ ~
I Planning v
BB Delivery ~
@ Monitoring v
M invoicing ~
© Interactive Tour

Help & Support

suppiyon f L

Confirmable Orders 4

43

Total Confirmable Orders

Order Status

Dated 2
Partly Confimed 3
Open 38

Confirm Orders

&Finance » Dashboard

Alerts >

619

Total New Alerts

Type
a

Inventory Alerts

FRA/ASN Alerts

35

167
[

Material Status Alerts

Demand Alerts

62

elnvoicing >

281

Total Billable ltems.

Billable Item Status

I
279

Billable ltems Due

Figure: Logistics & Finance Dashboard with the tile Settings and Master Data

Settings and Master Data

Down- and Upload Settings
> Format
> Download Profiles

Master Data
> Org. Master Data
> Performance Data

Packing Process Master Data
Material Weights and
Measures

> Packing Material
> Packing Instruction

You are in the Material Master Data screen. Here you can define master data either one by one or
use the Download Material xIs and Upload xIs functions.

My SuppiyOn = Logistis
Quick Search | Advanced Search

Search | | Reset

Material Master Data
Dok Ve |
Metersi« | Materisl Desc

345828
345828

& Fmance » Material Masier Data

~| Managa View~

Mn | Signal | Max  Red Del Oty
10000 0 20000
o 0 o
0 o 0
1100 o 4800
0 0 0
[ 0 [}
500 o 3000
0 o 0
[ 0 [}
1000 o 2000
0 0 0
0 o 0
1000 o 3000
0 0 0
1000 0 5000
1000 0 3000
1000 o 2000
0 o 0
0 o 0
0 ] 0
0 0

Back| [Download-

Download Material XL~

Uplond K5~ | [Ftoy -

21 matches of 21 entries:  Select all matches

Figure: Material Master Data overview screen

Clear 3

MinDel Qty.  Transp. T Plannes
1
1
1
1
1
1
1
1
1
1
1 4
1 a
2000 4 s
1 4
1 4
1 4
1 )
1 ®
1 48 FRAOI
1 72 FRAOI
1 @
Ent page [50 v

Dos

oo (Bets)

Cantact| @ ol for s page | Pri

Hide Soarch Area

My Search Profiles

Process

28 IPR

28 DELINST
28 DELINST
28 DELINST
28 DELINST
28 DELINST
28 DELINST
28 DELINST

Customs

Forward

CARAS
00900400

Thermapl
00900400

i 00900400

Kabelaun.

Kabefile . DE 00900400
Carr
Cam
Carrier

Fage | 1

The min and max amount quantities are defined in the customer ERP and cannot be changed by

you. You can define:

v

RND. Del. Qty. (rounding delivery quantity) — is considered when creating the planned

delivery. For one material the rounding quantity is for example 100. The system will not
accept 85 as a planned delivery.

August 2023
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v" Min. Del. Qty. (Minimum delivery quantity) — is considered when creating the planned
delivery. For one material the batch size is for example 2000. The system will not accept a
planned delivery of 1900 and will correct it up to 2000.

v" Transp. Time (Transportation time) — is considered when creating the planned delivery. In
this example 48 hours is shown. The next planned delivery is possible in 2 days.

Material Master Data

Doku View | Manage View~

[C] Material « Material Desc. Plant Buyer Min Signal Max. | Rnd. Del. Qfy. Min. Del. Qty. Transp. Time  fPlanner DoS ...
[£1| 127376 10000 0 20000 1 1 48 v
[ 345828 Sealing 0 0 0 1 1 48

[ 345828 O-Ring zur Abdi 0 0 0 1 1 48

[ 345828 0O-Ring Sealing (... 1100 0 4600 1 1 48

[F]) 5552345 Cover yellow 13 0 0 0 1 1 48

1| 747490 Thermoplastisch.. 0 0 1) 1 1 48

[C] 747490 Protection cap 500 0 3000 1 1 48

[ so0128 Zylindergehéuse 0 0 1) 1 1 48

[ 890128 Cylindrical Casing 0 0 0 1 1 48

[ 890128 Casing 1000 0 2000 1 1 72

01| 993745 Sleeve to conne... 0 0 0 1 1 48

[E] 993745 Kabelbaum zur 0 0 0 1 1 48

1| 993745 Cable Sleeve 1000 0 3000 100 2000 48

Figure: Material master data overview screen of Rnd. Del. Qty., Min. Del. Qty and Transp. Time
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7 How to create a process-based alert

SupplyOn supports you in complying with the logistics KPIs. As explained here, you can see your
current to-dos in the dashboard in the different order tiles. Additionally, you can set up an
individual email alert for specific situations. This ensures that critical situations are no longer

overlooked and logistics KPIs can be met.

1. Open the Dashboard
2. Click Alerts

3. Select Inventory Alerts

Dasnboara

Advance Shipping Notice > VMI (IPR)
Logistics & Finance

e 2 12

"
I Dashboart FPAGrestonDue  Pending FPA ASN Grastion Pendng ASN .

FPAIASH Alert
| e
Demana e

Due Deliveries 135 Material Situation at the end of Al e
W Oemons »
-
O
™ Pnning Oversue
Below Zera. 7
m oo Due Deliveries
livory
S 3
B Wonitoring serie Delivery Status
. - | o 1
W nveicing - N [ 1
Pkl Cevred 0
PR— 1

Create FRA Creats ASN v

© interactive Tour

Figure: Dashboard / Alerts

Define a search profile you are interested in. For further details how to create a search profile open

the media library and search for the tutorial VMI monitoring.

Build your search profile by clicking Add aline.

N o o &

days in the future and 90.

8. Test your search parameters by clicking Search.

My SuppiyOn > Logistics & Finance > Alert Overview

Quick Search Advanced Search

Inactive date v || equalto (selection of date| v- [ec] Delete fine

Status Stock Projected v || equalto v || Below Min. v Delete line

Status Stock Projected ~ |[equaito ~ |[Below zero v Delete line:

Status Stock Projected v | equal to v || Above Max. v Delete line

Occurence. v [days in e uture (nct_pal v |[s0] Add ine | Delete e

Search

Inventory Alerts (40)  FPA/ASN Alerts (165)  Malerial Status (128)  Demand Alerls (345)
[[] Ign.B. Ign. S  Material « Material Desc. Plant Buyer Status
[} 11348098 GLSDFUE TO39 REL D9, 13. B. Fischer Italia Actual stock: Atove Max.
B 11348008 GLSDFUE TC39 REL D9, 13, 8. Fischer ltalia Stock projected: Below Zero
B 11348008 GLSDFUE TO39 REL D8, 13. B. Fischer ltalia Stock projected "today": Below Zero
B 1234428 FDB201 Transistor B. Fischer DE Actual stock: Above Max.
B 127376 B. Fischer Italia Stock projected “today": Below Min.
|} 127376 B. Fischer Italia Stock projected: Below Min.
[} 127376 B. Fischer Italia Stock projes o
B 127376 & Fischer ltalia Actual stock
B 2025338 NS E02C 0,15 %C 6,35 mm B. Fischer ltalia Actual stock:
B 2025338 NS E02C 0,15 %C 6,35 mm B. Fischer Italia Stock projected “today": Below Zero
B 2025338 NS E02C 0,15 %C 6,35 mm B. Fischer Italia Stock projected: Below Zero
|} 345828 Sealing B. Fischer Italia Actual stock: Above Max.
[} 345828 Sealing B. Fischer Italia Stock projes oday": Above Max.
B 345628 seaing Actual stock: Below Signal
=} 345828 Sealing Stock projected "today": Below Signal
B 456828 Sealing B. Fischer Mexico Stock projected "today": Below Zero
3] 456828 Sealing B. Fischer Mexico Stock projected: Below Zero

40 matches of 74 entries:  Select ll matches | Clear seection Catres per page =

Figure: Alert Overview / Define Search Profile

Select the Search criteria, for this example select Status Stock Projection.
Leave equal to and select the entries below minimum, below zero and above maximum.

Determine by when you want to be informed about this situation by selecting occurrence,

Contact| @ Help for this page | Print

Hide Searth Area
My Search Profiles

Default View ~ | Manage View-

E-mail Nofification

Reset al Fiters

Stockprojected  Stocken Hand | Process Name | Planner  ASN (astUpd.)
9507 9507 SCM Melani
22758 9507 sCM Melani.
22758 9507 SCM Melani
9200 9200 SCM
651 2625 SCM SO_PL.
429 2625 SCM SO_PL.
K 2625 sCM SO_PL.
2625 2625 soM SO_PL.
2628 2628 SCM svs 3
650 2628 sCM svs 23002121 034,
659 2628 scM svs 2308121 034
7922 7922 SCM SO_PL.. 230821 02:2
10022 7922 sCM SO_PL.. 230821 02:2
7022 7922 soMm SO_PL.. 230821003
7022 7922 SCM SO_PL.. 23008/21 00.3
244536 3264 SCM AME 28004114 115.
244536 3264 SCM ANE 28004114 1157

’

page [ 1] o1
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You can save these search parameters as search profile and define the frequency of e-mail
notifications for it. Define a name for your search parameters and save it.

9. Define a name for your Search Profile.

10. Click on the Drop Down next to Manage View

11. and click Create new

11y SupplyOn > Logistics & Finance > Alert Overview Contact| @ Help for tis page | Print

Quick Search - Agvanced Search Hide Search Ar
ide Search Area

nscve date | [sauslto selecton ofdste] v~ i) Delete e My Search Profiles
Grcal n 90 days v Wf]
Status Stock Projected < | [cquaito ~ [Below Min 5 Delete fine ys | |v|Manage Vie

e Totcaton

Status Stock Projected v [equalto v | [Below zero ~ Delete fine
Status Stock Projected v | [cqualto | [Above Max. ~ Delete line Update
Occunrence ~ | [days in the future (incl. pal v |[s0 Add line | Delefe ine Delete.

Set aiunset defaull

Search

Inventory Alerts (14)  FPA/ASN Aleris (0) ~ Material Status (40)  Demand Alerts (0)

Default View ~ | Manage View~ Reset all Fiters

[ lgn.B. Ign. S | Material « Material Desc. Plant Buyer Status Stock projected Stock on Hand Process Name  Planner ~ ASN (last Upd.)
=] 11348098 GLSDFUE TO39 REL D9, 13. B. Fischer Italia Stock projected: Below Zero -22758 9507 SCM Melani 23/08/21 03:30:2¢
] 127376 B. Fischer Italia Stock projected: Below Zero -8 2625 SCM SO_PL... 12/08/21 13:25:1
] 127376 B. Fischer Italia Stock projected: Below Min. 429 2625 SCM SO_PL... 23/08/21 02:28:0
=] 2025238 NS E02C 0,15 %C 6,35 mm B. Fischer Italia Stock projected: Below Zero 859 2628 SCM Svs 23/08/21 03:49:0
=] 456828 Sealing B. Fischer Mexico Stock projected: Below Zero 244536 3264 SCM AME 28/04/14 11:54:0!
=] 456083 Sealing B. Fischer Mexico Stock projected: Below Zero -271900 0 SCM

=] 747430 Protection cap B. Fischer Italia Stock projected: Below Zero -282 2242 SCM SO_PL... 23/08/21 02:28:0
5] s90128 casing B. Fischer liaia Stock projected: Above Max 4a70 2570 sem SO_PL.. 2310821022751
5] 993745 Cable Sieeve B. Fischer liaia Stock projected: Below Min. 956 3473 scM SO_PL.. 2310821022801
(=} 995555 2Zweig zum Koppeln B. Fischer Italia Stock projected: Below Min. 0 0 scMm

(=] ASA-000024 Material24 B. Fischer Italia Stock projected: Below Zero -2639 661 SCM SO_PL...

(=] ASA-000041 Material41 B. Fischer Italia Stock projected: Below Zero -2629 671 sCMm SO_PL...

(=] NUK-000003 B. Fischer Italia Stock projected: Below Zero -53 000 1000 SCM 23/08/21 04:22:3¢
(=] NUK-000017 Starter 12V B. Fischer Italia Stock projected: Below Zero -250 0 scM

“ »

Inventory Projection] [Ignore status~

4 matchesof 71 enttes;  Selectallmatches. | Clearscection covesperosge [0 |

Figure: Alert Overview / Define and save Search Profile

12. Click E-mail Notification

Hide Search Area

My Search Profiles

crifical in 80 days |v | Manage View~
E-mail Motification

Figure: Alert Overview / Define E-mail Notification for Search Profile
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13. The just created search profile is automatically selected.
14. Set the tick next to Active.

15. Define the notification period, for example on a daily basis at 8:15 am in the morning.
16. Click Save

My SupplyOn = Logistics & Finance = Alert Overview = Email Notification

E-mail Notification

EBased on Search Profile | critical in 90 days v

| B Active |

Alert Motification Type
(O] as Attachment @) as Pure Text

Frequency

Periodic (according to your timezone: (GMT+01:00) Europe/Berlin)
Monday Tuesday Wednesday Thursday Friday [ Saturday [ Sunday

| ® Daily at :I

O Hourly from [8:00 [+ [to[17:00 |+ ]every[s || hour(s)

===

Figure: Alert Overview / E-mail Notification

In this example you will receive an e-mail notification as soon as the critical situation occurs.
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8 Roles and Rights

Note

On the following help page it is described how you as a CompanyAdmin of your company can
create users with the corresponding roles for your colleagues:
https://service.supplyon.com/topcases/?lang=de&articleld=2062

Basic information about your user account, its roles and rights are visible under Administration —
My User Account.

Services v Administration v News

My User Account

My Substitutes

Customer Responsible

Figure: Administration > My User Account

As soon as you click here, you will see basic information like your username, email address etc.

Contact data
User ID*: SiemensTest_User_TTA1
First name™ | Healthineers |
Last name™ | Siemens |
Salutation®: | Not selected | v
E-mail*: on.com |
Phone™: |0 |
Language™ | English | v
Two-factor O Enabling for user
authentication:
Change Password

Figure: My master data
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To be able to commit the actions of this guide, the following roles in the tab “My roles” are
required:

My master data My service settings My substitutes Privacy settings

Expand the groups for a more precise roles assignment. Expand all | Collapse all
AirSupply related roles (not assigned) Expand 0]
Company Administration (assigned) Expand 0}
Contract and Invoice (not assigned) Expand M
Management Cockpit (not assigned) Expand (0
Sourcing and Engineering (not assigned) Expand &
Supply Chain Collaboration (partially assigned) Expand 0]

Figure: My roles

Group: Supply Chain Collaboration

VMISellerAdmin:

v Display of VMI articles, display and changing of supplier master data
WebEDISellerAdmin:

v Access to Supply Chain Collaboration.

The SupplyOn Company Admin is authorized to create new users or to assign roles to already
existing users.
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Depending on whether you were already an existing supplier on SupplyOn or are completely new,
the role assignment differs:

For newer suppliers you should see this screen here:

Shipping, Goods Receipt, Warehouse...

Q|0 O O O

O

Areas of responsibility

Name 4

Company Administration

Order Fulfilment, Finance Processes

Quality Management

Sales

Shipping, Goods Receipts, Warehouse ...

Supply Chain Administration

Description

Company master data, users and permis...

Supply Chain Management.

Supplier Quality Management (QM).

Sourcing to Contract, Progress to Order ...

Shipping, goods receipts, warehouse ma...

Demand, logistics and finance processes.

More information

More information

More information

More information

More information

More information

More information

Figure: User Management with Edit User and Areas of responsibility

After clicking More information, the following help page is displayed. Here you can see the tasks
the user can fulfill with this responsibility.

Shipping, goods receipts, warehouse management

Supply Chain Collaboration

Displaying demand and logistics data

Creating FPAs and ASNs

Editing planned receipts

Editing stock movements

Creating goods receipts

Managing masterdatal

Figure: Help page with explanation for Shipping, goods receipt and warehouse management responsibility
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